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VC EtherCAT Servo Cooperate with 

Omron Master Station Operation Routine 

● Operation main flow 
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Configuration operation process： 
 

11.2.1 Ready to work 

1） To install the software of sysmac studio, it is recommended to 

install V1.10 and above. 

Sysmac studio V1.03 and below cannot recognize third-party servers. 

Sysmac studio V1.09 patch version, V 1.10 and above versions, no longer 

check whether the manufacturer ID in the xml is consistent with that in 

the program, it can match all VC EtherCAT xml files 

For Sysmac studio software version 1.05~1.09, it is necessary to judge 

whether the three parameters of 1018h in the xml file are consistent 

with those in the program. Among the currently released versions, V1.1, 

V1.9, V2.1 and above can be used. 

2) Import the device description file. 

Use the device description file of "VECServeecat_tensin.hex.xml" and 

above, the file placement path is as follows: OMRON\Sysmac 

Studio\IODeviceProfiles\EsiFiles\UserEsiFiles 

When the xml file is placed in this path for the first time, the Sysmac 

studio software needs to be restarted. 

3) Set the computer's network connection properties 

If the computer and NJ controller choose USB direct connection, skip 

this step; 

If the computer and NJ controller choose Ethernet to connect directly, 

set the TCP/IP properties of the computer, as shown in the figure 

below： 



 

 
 

 

 

 

 

11.2.1 Servo parameter setting 

1) Servo parameter P08.41 sets the servo station number, this example is 

set to 1 

2) Correspondence of digital input bits： 

 

The functions of each bit of the 0X60FD digital input of the Omron controller 

are allocated as follows: 

Bit Signal describe 

0 
Reverse overtravel 

switch 

Each Bit reflects the 

current DI terminal logic 

of the drive; 

0-Logic is invalid; 

1- Logic is valid; 

1 
Forward overtravel 

switch 

2 Origin switch 



 

3-15 NA In the process data 

configuration, please 

assign 60FD according to 

this table 

16 Z signal 

17 Probe 1 

18 Probe 2 

25 DI emergency stop 

26-31 NA 

 

2）connect： 

 

11.2.3 Omron NJ background software configuration 

1）New Construction 

ECAT_Out 

ECAT_In 

Encoder 

Control terminal 



 

 
Equipment: Choose according to the actual NJ controller model 

Version: New version 1.09 and above 

2) Communication settings 

After entering the main interface, set the connection method between the 

computer and the NJ controller in "Controller"-  "Communication Settings". 

Select "USB—Direct Connection", then directly proceed to "USB 

Communication Test", if the test is successful, proceed to the next step; 

Select "Ethernet—Direct connection", then set the IP address to the IP 

address controlled by NJ: 192.168.250.1, and then perform "Ethernet 

communication test". If the test is successful, proceed to the next step;

 
 

3) Add equipment 

① Manually add, please follow this step to import the XML file before 

adding, if the file has already been imported when installing the software, 



 

this step can be omitted

 

②After adding the XML file, close the software and reopen the software. The 

previously imported file will be automatically imported into the software as a device. 

VEC products can be found in the device components on the right. 

 

③Find "VECServo" from the equipment group on the right and click double-click, and 

all the version numbers of this component will be displayed in the version display 

column below. There is only one version. Double-click the component of this version, 

and the system will automatically add the component to the Master master. Below the 

station (a slave station appears under the master station), it means the addition is 

successful (if there is no related servo description file in the ESI library, the 

device cannot be found in the device group on the right, you need to follow the 



 

previous step ① after importing the XML file, and then proceed This step operates） 

④After the component is successfully added, you can configure the component node. 

The figure below shows the configuration of the basic information of the node. 

 

 

⑤Next, proceed to process data configuration, first click the "Edit PDO Map Settings" 

button at "A:" in the above figure with the mouse to enter the PDO mapping dialog 

box, and select a set of appropriate PDO mapping data according to the function of 

the component application and the working mode. , Click the "OK" button.  

 

 



 

 

⑥ After the completion of step ⑤, the VEC component is officially hung under the 

master station as an IO device (at this time, it is only used as an ordinary IO 

device and cannot be used for motion control). Since the servo is usually used as a 

motion control device (axis), the next step is to configure the axis. Add a motion 

control axis as shown in the figure below. After adding, you can change the axis 

name according to the actual situation. Here, use the default axis name "MC_Axis000" 

" 

 

⑦After the new axis is created, double-click the new axis to set the axis parameters. 

The setting items are as follows. 



 

 
 

 

 

a. Axis allocation. 

 

 

 

b. Process data mapping. According to the PDO mapping object selected in "4) Parameter 

Configuration ① PDO Mapping Setting" above, assign output (controller to device) 

parameters and input parameters (device to controller) one by one. Note that the 

object name, node number, and index number must be Choose the right one. Each selected 

mapping object must be allocated correctly, otherwise an error will occur. 60FD must 

be mapped by bit, and must be mapped to be consistent with Omron's according to the 

following figure. 



 

 

 

c. Unit conversion settings 

According to the actual motor resolution, set the "command pulse number for one 

revolution of the motor" (for example, a 2500 line motor selects 10000 pulses per 

revolution). It needs to be set correctly, and the working stroke of one revolution 

of the motor can be kept as default. Actually it is similar to the electronic gear 

conversion done on the host computer, there is no need to set the conversion ratio 

inside the servo 

 

 

 

d. Acceleration/deceleration, jump, maximum torque, etc. settings



 

 

 

e. Software limit setting, software limit function can be selected, the software 

limit will take effect after using the host computer to return to the origin

 

f. Back to reference point method setting

 

Setting the origin return method requires special attention. It involves the 

cooperation of the servo and the upper computer function, please refer to the 

following table for setting 



 

NJ software description servo corresponding function terminal configuration 

Origin approach signal origin switch (nFn34) DI10 

External origin input probe input 1 (default, no function number) DI8 

Z phase signal input motor encoder Z phase signal N/A 

Positive limit input P-OT (nFn43) DI1 

Negative limit input N-OT (nFn44) DI2 

According to the actual mechanical conditions, select the homing mode of the host 

computer, and set the homing speed, acceleration, and origin offset. 

Note: Z signal and external origin switch 2 choose 1, they will not be used at the 

same time 

NJ software description Servo corresponding function Terminal configuration 

The origin is close to 

the signal origin switch 
(NFn34) DI10 

External origin input 

probe input 1 
(Default, no function number) DI8 

Z phase signal input 

motor encoder 
Z phase signal N/A 

Positive limit input P-OT P-OT (nFn43) DI1 

Negative limit input N-OT (nFn44) DI2 

 

 

 

Specify the return-to-origin action to 

be rewritten. 

0: Designated as nearby avoidance, near 

origin input OFF 

1: Designated as nearby avoidance, near 

origin input ON 

4: Designated as near origin input OFF 

5: Designated as near-origin input ON 

8: Designated as limit input OFF 

9: Designated as nearby avoidance, 

origin input shielding distance 

11: Only limit input 

12: Designated as nearby avoidance and 

contact time 

13: Designated as no near-origin input, 

touch-origin input 

14: Origin preset 

 

Origin proximity input OFF: refers to the origin search signal after encountering 

the falling edge of the origin proximity switch. 

Origin proximity input ON: refers to the origin search signal when it encounters 

the rising edge of the origin proximity switch. 

Nearby avoidance/approach reversal: that is, when the homing starts, the origin 



 

approach signal is ON, and it runs in the reverse direction immediately after 

encountering the falling edge of the origin approach signal; 

Origin input mask/shielding distance: After the host computer receives the origin 

search signal (such as the edge change of the origin approach signal), the origin 

signal is shielded within the set distance, and the origin signal is received after 

this distance; 

Hold time/contact time: After the host computer receives the origin search signal 

(such as the edge change of the origin approaching signal), the origin signal is 

shielded within the set time, and the origin signal is received after this period 

of time; 

Zero position preset/origin preset: the current position is taken as the origin, 

the motor does not move, and the upper computer writes the origin offset into the 

position command/position feedback in the upper computer. 

◆ Note: 

All homing methods are ultimately used to find the origin signal at low speed. If 

there is a high-speed running section, the origin signal will be shielded during 

the deceleration process from high speed to low speed. 

 

⑦ After the above settings are completed, the added IO slave device at this time 

has been formally associated with an axis that can be used for motion control. The 

user can use LD or ST instructions in the program to call the motion control module 

to control the device. The following describes the setting of the DC clock. The 

default clock is 1ms. In the offline state, you can change the synchronization 

clock (the cycle of the main fixed-period task) in the "Task Settings". In NJ, the 

name is "PDO Communication Cycle". , Re-power on and switch to online status, the 

changes will take effect.

 



 

 

 

 

 

 

 

 

4) Program control 

After the configuration is completed, the servo operation can be 

controlled by writing the PLC program. When using the "MC_POWER" module, 

it is recommended to increase the axis servo status bit 

"MC_Axis000.DrvStatus.Ready" to determine. Among them, MC_Axis000 is the 

axis name to avoid the situation that when the PLC program runs first, 

but the communication has not been configured yet, the function module 

reports an error and cannot be enabled. 

 

 

5) Online operation 

After all the settings and programming are completed, switch to the 

online state and execute the download to the controller “  ”。 

Use synchronization “  ”，Compare the difference between the current program 

and the program in the controller, and then decide whether to download to the 

controller or upload from the controller according to needs “ ”，You can 

also leave it unchanged. 

NOTE Regarding the mixed use of G5 series servos and third-party servos: 



 

According to user feedback, in the same network, regardless of the order of site address 

allocation, NJ will give priority to matching G5 series servos. After the G5 series servo network 

enters the operating state (Operation state), third-party servos will be configured. 

  



 

VC EtherCAT servo with Beckhoff 

TwinCAT master station operation routine 

● Operation main flow 
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12.2.1 Installation and connection 

1) Install TwinCAT software 

The twinCAT software on Beckhoff's official website supports up to win7 32-bit 

system, but win7 64-bit system does not support it. 

Windows xp system: It is recommended to install tcat_2110_2230 

Windows 7 32-bit system: It is recommended to install tcat_2110_2248 and above 

NOTE: Regarding the network card, you must choose a Fast Ethernet card with an 

intel chip. For the supported network card chip models, please refer to the 

announcement list on the Beckhoff official website (address link: 

https://infosys.beckhoff.com/english.php?content 

=../content/1033/tcsystemmanager/reference/ethercat/html/ethercat_supnetworkcontrol

ler.htm&id=). Other brands of network cards may not support EtherCAT operation. 

 

2) Copy the EtherCAT configuration file (VECServoOML.XML) of the Vector E series 

servo to the TwinCAT installation directory: \TwinCAT\IO\EtherCAT.

 
 

3) Open TwinCAT system Manager software



 

 

 

3) Install TwinCAT network card driver

打开 

In the above menu "Show Real Time Ethernet Compatible Devices...", the dialog box 

shown below will pop up, after selecting the local network card in the 

"Incompatible devices" column, click "install". 



 

 
After the installation is complete, the installed network card appears in the 

"Installed and ready to use devices" column as shown below (try to choose a 100M 

network card with intel chips, other chips may cause unsuccessful installation or 

unstable problems)

 

 

4) Connect the target controller 

If the target controller is the local machine, you can omit this step and go 

directly to the next step "Search and add devices"; if the target controller is not 

the local machine, you need to perform the following steps (take Beckhoff CX5020 as 

an example) 

(1) The default IP address of Beckhoff CX5020 is: 169.254.XX, and the subnet mask 

is 255.255.0.0, so you need to set the computer's IP and the controller to the same 

network segment (the mask is the same, the last two digits of the IP are set 

Different) 

(2) Enter the target controller search interface according to the operation below 



 

 
 

(1) You can enter the target controller name or determined IP through the input box 

on the right of "Enter Host Name/IP" for direct search, or use "Broad cast Search" 

for broadcast search. After the search is successful, click the "Add Route" button, 

and the dialog that appears Enter the user name and password in the box (the user 

name of the XP/WIN7 system is Administrator, the password is 1, and the WinCE 

password is blank), and then "Connected" in the target controller information bar 

will display "X" to indicate that the target controller path has been added 

successfully. Close the dialog The box returns to step (2), select the target 

controller and click "OK". So far, the steps of establishing the actual connection 

between the computer and the controller are completed. The process of connecting to 

the target controller is to easily add slave devices through online scanning later

 
Through the status display in the status bar in the figure below, you can observe 

the actual connection of the target controller 



 

 The current target control 

is running  

 The current target control is 

configured 

 The target controller is 

not connected 

 

12.2.2 Add slave devices online 

1）Operate as shown below to switch the controller state to configuration mode 

 
2) Select the scanning device in I/O Device to perform automatic scanning  

 

3) The prompt window during the scanning process is as follows, the 

user can decide whether to activate the "Free Run" operating mode according to 

their needs. For servo control, basically it runs in the "DC synchronization" 

mode, so you can select "no"



 

 

 

4) After the scan is successful, expand the I/O Device tree structure, at the 

bottom layer, you can see all local and remote I/O modules and devices  

 

 

12.2.3 PDO configuration 

1) After the slave exhibition is added, we need to configure each slave node to 

send and receive PDO process data. The configuration content is selected according 

to the actual application of the slave. A total of 6 groups are defined for 

receiving and 5 groups for sending, including 0X1600 and 0X1A00. For variable 

mapping, the user can freely combine the configuration content. Others are fixed 

mappings and cannot be changed. For specific options, please refer to the 

introduction of the PDO mapping section of the servo manual. All servo nodes need 

to be configured one by one according to the following figure. 



 

 

2) Through the toolbar “ ”Activate the configuration and click “ ”Run, you 

can perform some simple operations and view the status of the node and other 

parameters through the following figure 

       

12.2.4 Associated NC axis 

1) Right-click NC-Configuration, Append Task: 

 

2) Edit the task name and click OK to directly use the default name. 

 



 

3) Configure NC Task 

 
There are two NC tasks, 

One is the SAF task, the default period is 2ms. This is the interval of interpolation during 

trajectory planning, the cycle of position loop calculation, and the cycle of data mapping 

between TwinCAT NC and TwinCAT IO. If it is synchronous mapping, then it is the EtherCAT 

communication cycle where the servo drive is located. 

The other is the SVB task, the default period is 10ms. This is the cycle of data mapping between 

PLC and NC: 

 

 

 

 

4) Add an axis as shown in the figure below. After the Axis is created, the type 

cannot be modified. 

 

Continuous: The default type, continuous axis. NC can continuously obtain the state of the axis 

and control its precise positioning or other actions. Choose this type without special instructions. 

Encoder Axis: Encoder axis. NC can only read the position, but cannot control the movement of 

the axis. This kind of axis may be PLC controlled, it may be controlled by other systems, or it may 



 

be manual. Usually this kind of shaft is used as the main shaft of the two-axis linkage, and the 

slave shaft follows it for gear or cam coupling. 

Multiple: The number of added axes, all types of axes (including NC I, Fifo, Kinematics, etc. 

Channels) cannot exceed 255 in total. 

Time Generator: The time axis does not need to be enabled and cannot be stopped. It will always 

move at a constant speed of 1mm/s. But you can use the button Set Actual Position in Function 

or use MC_SetActualPosition in the PLC program to set the current position. In practical 

applications, the time axis is often used as the main axis, and the actual axis follows it as an 

electronic gear (Gear) or cam movement (Camming). 

Discrete Axis (Two Speed): Not commonly used. 

Low Cost Stepper Axis (dig I/O): Not commonly used. 

 

5) After the axis is added, the following figure 

 

6) Connect or associate the NC axis with the scanned IO device (if it is a virtual 

axis, it does not need to be associated) 

 

12.2.5 Axis parameter setting 

1) Axis parameter settings, mainly encoder (Enc), drive (Drive), PID (Ctrl) 

controller settings. 

Enc is to set the parameters of the encoder, the most important is the pulse 

equivalent of the encoder (Scaling Factor). 

Drive is to set the drive parameters, especially when the position loop is 

processed in the NC, the parameters here must be set. 

Ctrl is to set the PID parameters of the position loop. If the position loop 

is processed in the servo drive, this parameter is invalid.



 

 

（1）General 

 

（2）NC-Encoder settings, select the type in the red box

 

（3）Parameter 
Encoder Evaluation 

Invert Encoder Counting Direction：The encoder counting direction is reversed, and 

the default is False. If you want the motor to rotate forward and the position 

feedback value is reduced, you need to set it to True. At the same time, 

reverse the motor polarity (Invert Motor Polority on the Parameter page of 

Drive under Axis item). 

Scaling Factor: The distance corresponding to the encoder pulse of each 

position feedback. For example, if the motor rotates 10,000 pulses per 

revolution, and the motor rotates one revolution corresponds to 60mm, the 

Scaling Factor should be 60/10000=0.006 mm/Inc. 

Tip: For no-load debugging, it is customary to set one circle to 60mm, so that 

the speed of 1mm/s is equivalent to 1 circle/min. Because the rated speed unit 

of the motor is rpm, it is more intuitive to use rpm as the speed unit during 

debugging. 

Position Bias: The offset between the origin of the device and the zero 



 

position of the encoder. After the mechanical installation is fixed, this value 

will not change. When using an absolute encoder, there is no need to search for 

parameters every time, just use this offset to calculate the device origin. 

Because the position of a multi-turn absolute encoder is unchanged each time it 

is powered on, and the position of a single-turn absolute encoder is a Modulo 

value each time it is powered on. 

Modular Factor: Modular length. Usually refers to the distance of Axis movement 

in a process cycle, the default value is 360. For example, the rotation spindle 

positioning action, the current position is 30 degrees, to be positioned to 60 

degrees, the motor can rotate forward 30 degrees, or it can rotate 390 degrees, 

and eventually reach the same point. If the action is not repeated within a 

fixed length, this parameter can be ignored. 

Encoder Mask: Encoder mask, related to the number of bits of the position 

variable, usually 32 bits, that is, the maximum is 0xFFFFFFFF. 

Encoder Sub Mask: Encoder Sub Mask, which is related to the maximum feedback 

value. For example, for a 16-bit incremental encoder, it will become 0 if the 

positive direction exceeds 65535. At this time, NC will deal with the zero-

crossing problem, knowing that the position is increasing steadily, instead of 

There is really a reverse mutation. At this time, Sub Mask should be set to 

0x0000FFFF. 

 

 

Reference System：Reference point coordinate system: 



 

 
The three parameters of Encoder Mask, Encoder SubMask and Reference System are 

combined to determine the "rule of converting the position feedback variable value into the 

actual position of the NC axis", and the Scaling Factor determines the conversion ratio. 

Under normal circumstances, these three parameters do not need to be set. After selecting 

the encoder type, the NC has determined their values. But after understanding the role of 

these parameters, you can do some flexible processing yourself according to the 

characteristics of the project. 

Homing: 

Invert Direction for Calibration Cam: Whether to move in the negative direction and 

find the origin. 

Invert Direction for Sync Impulse Search: After finding the origin, whether to move in 

the negative direction to find the sync pulse. 

Calibration Value: Reference point position. Usually this value is given in the PLC 

program, and it does not affect whether it is set here or not. 

Reference Mode: Seek reference mode. The homing mode with action 

selects'MC_DefaultHoming','bCalibrationCam1' is the reference origin signal, when this 

signal comes (rising or falling edge, set in the shaft encoder parameters), detect the Z phase 

signal or detect probe 1 Signal to set the origin. 

 

Other Settings: 

Encoder Mode: Encoder mode, there are the following three options, 

Pos: The encoder is only used to calculate the position. It is used when the position 

loop is in the drive. 

PosVelo: The encoder is only used to calculate position and speed, and is used when 

the position loop is in TwinCAT NC. 

PosVeloAcc: Choose when TwinCAT NC uses encoders to determine position, velocity 

and acceleration. 

 

Time Compensation 

Time compensation refers to dead zone compensation, which is often caused by 

sampling delay and is related to the NC cycle. Usually, you don't need to set it, and you can 



 

add this compensation when the accuracy is particularly high. 

 

Online: 

Monitoring page, no need to set 

 

2) Drive settings 

Generally, do not need to be set 

 

3) Ctrl control parameter setting

 
 

Position ring: drive 

Speed loop: drive 

Drive: 

position mode 

The default Position Controller P can be 

used, but the actual P value does not 

work. 

Position ring: 

TwinCAT NC 

Speed loop: drive 

Drive: Speed 

mode 

Usually you can use the default Position 

Controller P, you can adjust the P value 

to change the response speed. Change the 

double P or PID only under special 

circumstances 

 

Note: The speed loop can also be completed by TwinCAT NC, sending the target torque to 

the drive every cycle. But in fact, such use will greatly increase the load on the CPU and 

network, and few projects will use it in this way. 

 

12.2.6 Commissioning of TwinCAT NC axis 

The debugging and parameter setting of the TwinCAT NC axis are often carried out 

alternately, and the parameters are determined and modified during the debugging. The 

debugging of the project is divided into two parts: one is the debugging of the logic action, and 

the other is the debugging of the servo axis. The former can be carried out on the virtual axis, 

and the latter can be carried out in the NC debugging interface of the System Manager without 

the PLC program. After the logic actions and dynamic characteristics of the servo axis have been 

debugged, the PLC program can be used to control the servo axis actions (when debugging on 

the NC interface, please switch the PLC program to Stop mode or do it when you have not 

associated the PLC program. If it is associated with a PLC program for axis control and it is 

already in RUN mode, it will affect your use of the NC debugging interface). The following 



 

describes how to debug the servo axis in System Manager.

 

1) General 

Name: The name of the axis, writable. 

Type: The category of the axis, which is determined when the axis is created, and cannot be 

modified here. 

Id: The serial number of the axis, which is numbered in the order of creation and cannot be 

modified. 

Create symbols: Select this option, and the external program (e.g. scope view) can access the 

parameters of the NC axis through the variable name. 

Disable: Select this option and the NC axis will stop running.。 

2) Settings 

For Unit and Display settings, try to use the default values to avoid confusion caused by the 

unit mismatch of speed, displacement, and acceleration. If the hardware is not connected 

(not associated with the actual IO device), this page does not need to be set. 

Axis Type: Because the protocol layer is CanOpen DS402, CanOpen DS402/ProfileMDP742 

should be selected at this time 

"Link to", the system will pop up the matching hardware, select the target axis, and press 

"OK". 

3) Parameter 

Axis debugging interface sets the parameters of the axis. After the setting is completed, you need 

to click the "Download" button to make the new parameter values effective. Some parameters 

can be modified at any time, such as Dynamic, and some parameters cannot be modified in the 

Enable state, such as Scaling Factor. Save the file and reactivate the configuration, and all 

modifications will take effect. 

Velocity: Speed parameter 

Reference Velocity: parameter speed, that is, the speed at the maximum value (32767) of the 

speed variable of Drive. The unit is mm/s. 

Maximum Velocity: Maximum velocity. When debugging or PLC control axis action, the target 

velocity should not exceed this value, and should be slightly lower than the reference velocity, 

usually set to about 95% of the reference velocity. 

Manual Velocity (Fast/Slow): The speed of the standard fast mode and standard slow mode 

when Jog is inching. 



 

Calibration Velocity (Towards/off PLC Cam): The speed when going to the reference point and 

leaving the parameter point when seeking a reference. 

JogIncrement (Forward/Backward): The displacement step of forward jog and reverse jog.

 

Limit Switches：Soft limit parameter 

 

False：The soft limit function is disabled by default; 

Minimum / Maximum Position：Minimum position and maximum position. The action 

stops when it exceeds, and NC reports an error. 

Monitoring：Monitoring function settings 

 

Position Lag Monitoring：Following error monitoring, when it is True, monitoring 

is allowed, if the following error exceeds 

Maximum Position Lag Value，NC reported an error. Following error (also known as Following 

Error) can be monitored online in the Lag Distance shown in the figure below during debugging.



 

 

Position Lag Monitoring is True by default. If the virtual axis is used for testing or PID debugging 

is not performed, this function can be temporarily disabled. If the NC has a Following Error alarm, 

you need to adjust the Kv-Factor in the above figure, or the dynamic characteristics 

(acceleration/deceleration) of the Dynamics page. 

Position Range Monitor and Target Position Monitor: Enable the position range and target 

position monitoring functions. Once the actual position enters the setting range, the 

corresponding NC mark will be set. During debugging, the status (phys.) of the flag can be 

displayed from the status (phys.) in the above figure. 

4) Dynamic 

 

There are two ways to set the dynamic characteristics of the NC axis: one is to 

set the time from the acceleration to the specified speed, and the other is to 



 

directly input the acceleration value. The author's experience believes that 

the method of setting the acceleration time is relatively intuitive and easy to 

modify. 

In addition to setting the acceleration, you can also set the jerk. There are 

also two methods available: one is to pull the slider of the a(t) and v(t) 

characteristic curves, and the other is to directly input the Jerk value. The 

author’s experience believes that the method of pulling the slider is 

relatively intuitive. The farther to the right, the faster the jerk and the 

greater the impact when the mechanism moves. On the contrary, the smoother the 

action of the mechanism. 

The dynamic characteristics should match the inertia of the motor, the inertia 

of the load, and the rated torque. Under the premise that the mechanical and 

electrical characteristics can be achieved, and the process permits, the 

shorter the acceleration time, the faster the speed of the entire system and 

the higher the production efficiency. 

5) Online（Test jog） 

This is the debugging page, which is only available when the current configuration file 

is consistent with the actual configuration file of the target system and the target system is 

in the Running mode. Therefore, after configuring the NC axis, it should be saved, and then 

log in to the target system and activate the configuration, and switch to operation

 

 

6) Functions（Test single axis motion） 



 

 

This is the function debugging page. After enabling Axis on the Online page and 

the jog is normal, test the single-axis specified action on this page. 

Test whether the positioning of the axis is accurate to verify whether the 

pulse equivalent setting of the encoder is correct. Usually, Relative is used 

to let the motor go one circle, or let the mechanism go a specified distance. 

To adjust the PID parameters of the NC or drive, Reversing Sequence is usually 

used to make the motor forward and reverse. With the Scope View software of the 

electronic oscilloscope, the speed and position waveforms of different PID 

parameters can be continuously observed. Optimize the PID parameters, so that 

the speed fluctuation is small, and the position does not overshoot.  

7) Coupling 



 

 

On the function debugging page, after enabling Axis on the Online page and 

the jog is normal, test the dual-axis linkage on this page. By selecting 

Coupling Mode, you can choose electronic cam or electronic gear coupling. If 

you choose the cam mode, you also need to fill in the cam number in the Table 

Id box. If gear is selected, enter the gear ratio in Coupling Factor. 

After clicking Coupling, the value of Setpoint in the upper right corner 

turns red, which indicates that the axis is in the coupled slave state at this 

time and cannot perform positioning, constant speed and other actions, nor can 

it set the current position or search parameters. 

8）Compensation 

 

Function debugging page, after testing that the specified action of each axis is normal 

on the Function page, test the position compensation here. 

System Manager MC_MoveSuperImposedExt 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: After enabling, you can pass 5), 6), 7), and 8) to test each function 

separately. 

12.2.6 PLC as NC control routine 

1) Open the "TwinCAT PLC Control" software, select the controller type, and 

create a new project,

 

Compensation Mode Mode  

Velo Red Additive SUPERPOSITIONMODE_VELORE

DUCTION_ADDITIVEMOTION 

Velo Red Limited SUPERPOSITIONMODE_VELORE

DUCTION_LIMITEDMOTION 

Length Red Additive SUPERPOSITIONMODE_LENGTH

REDUCTION_ADDITIVEMOTION 

Length Red Limited SUPERPOSITIONMODE_LENGTH

REDUCTION_LIMITEDMOTION 

Acc Red Limited  

Acc Red Limited  

Compensation Delta Distance  

Max Boost Velocity VelocityDiff  

Max Acceleration Boost Acceleration  

Max Deceleration Boost Deceleration  

 Jerk  

Process Velocity VelocityProcess  

Compensation Range Length  

  



 

 

2) Select the programming language, here select LD

 

3) Add motion control function library "TcMc2.lib"

 

After adding, it will be displayed as follows

 
 

 

 



 

 

4) Write the PLC control program, call the motion control module through 

the library, and press the F1 key to enable the instruction help 

 

 

5) Create a program through POU 

 



 

6) Add the written program as a task to the task configuration 

area. Programs that are not added to the task will not be downloaded to the 

controller after being compiled. The controller only runs the added task 

 

 

7) Save and compile the program. After compiling, a .tpy file will be 

generated for TwinCATsystemManager to call 

 

 

 

8) Return to the TwinCAT system Manager software interface to call the .tpy 

file generated above



 

 

 

9) Open the structure of the imported file, and associate the input and 

output parts with the corresponding NC axis. After the association, an arrow 

pointing to the upper right corner will appear as a mark 

 

 

10) Save and activate the configuration, switch to DC mode to run, and then 

return to the "TwinCAT PLC Control" software, open the program for online 

monitoring and operation 



 

 

Ctrl+F7更新写入值 

 

 

11) The entire configuration process is introduced  
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EtherCAT communication configuration and axis configuration:： 

1. After connecting the Ilium controller (the controller is connected to two VECServo in this 

configuration case), open the RTPLC configuration tool through "Start -> ISAC -> RTPLC -> 

PLC HMI", and click "File -> Connect to ", select Remote machine: type machine name, set 

the IP address (the default address of the controller is 1.1.1.1, at the same time, the computer's 

IP address should be in the same segment as this address, that is, 1.1.1.x)） 

 

 
 

After clicking OK, the Synchronization dialog box pops up, select “Select all”, then select 

Upload to upload the current configuration of the motion controller to the PC, and click Close 



 

when finished; 

 
 

2. Before configuring the EtherCAT network, you need to place the description file (XML file) 

of the connected device in the following folder: C:\isac\exe\ios\Ethercat 

 

3. The configuration process of EtherCAT is as follows: 

1) Open the IO configuration window through PLC HMI -> View -> IoSource -> 

IoSource Main Viewer 

 

 



 

2) Click Ethercat Bus in the DeviceView window on the left, then open the EtherCAT tab 

in the right window, and click the Scan button; 

 
 

3) After the online scan is completed, there will be a red font prompting that the 

configuration information has been changed, and the Save Changes button is activated. At 

this time, the scanned slave devices are listed under the EtherCAT Bus node on the left 

(connected in this configuration case) Two VECServo). Save the configuration information in 

a local file by clicking the Save Changes button. 

 

 

4) In the pop-up Synchronization dialog box, select “Select all”, then select Download 

to download the current scan configuration to the controller (after the configuration is 

completed, when the window pops up, select Download); 



 

 
5) Click the Advanced Settings button to enter the advanced settings, select VECServo-

addr:1002 (the closest servo to the controller) in Distributed Clorks, as the distributed clock 

reference, click OK; 

 

点 Click Save Changes in the EtherCAT tab to save the settings; 

 

4. Axis parameters and axis type configuration (in this example, two EtherCAT axes and two 

virtual axes are configured) 



 

1). You can open the OMAX hardware settings window through the menu bar "Settings 

-> OMAX optional module -> Hardware service axmgr..." to configure the protocol to be 

used and the total number of axes. 

 

 
2) Select EtherCAT boards, and add an EtherCAT spindle configuration via the Append 

button in the right window. 

 
 



 

3) Configure the communication cycle of the EtherCAT master station and the number 

of axes supported. 

 

 

Mainly modify the following parameters, and keep the default values for other parameters: 

Axes number: The number of EtherCAT connected axes. In this example, there are two 

EtherCAT axes, so it is set to 2. 

Disableboard: Whether to disable this parameter configuration. If this parameter is set to 

True, it is disabled, and if it is set to False, it is not disabled. Set to False in this example. 

Interrupt time: EtherCAT communication scan cycle, in ms, set the communication cycle to 

2ms here. 

Add two virtual axis interfaces to Simulated axes boards in the same way as above, and 

then click OK; 

 

5. Axis allocation and initialization of axis configuration parameters 

 

After configuring the number of axes used in the system, you can add the axes to the 

corresponding channels before they can be accessed. In this example, take a channel as an 

example: 

1). Open the channel configuration window through the menu Settings -> OMAX optional 

module -> Axis Module (OMAX)... 



 

 

 

When the number of axes currently added has not reached the set total number of axes, 

you can click the button  Add axis, or via button  Delete the selected axis. 

Configure parameters through the parameter template: For axis general parameters, you 

can select the axis and then click the Init from button to select the corresponding template 

to configure the parameters of the current axis, so that only a few parameters need to be 



 

modified (here, VECServo selects the initialized template as Delta_ASDA);

 

After all the axis parameters are initialized, click the Apply button to apply the loaded 

parameters, and click OK to keep exiting.  



 

6. Axis general parameter setting 

 

Open the Axis Configuration window through the menu bar "Settings -> OMAX optional 

module -> Axis service axmgr..." to configure the general parameters of the axis. 

Config： 

 

◼  Description: just a text description of the current axis, just add it as needed; 

◼  Descriptive name: axis name, which can be added as required, but the PAC 

system accesses each control axis according to the axis number; 

◼  Enable software limits: enable software limits. Yes: Enable the software limit, 

and the Positive software limit and Negagive software limit settings are valid; No: 

Disable the software limit, and the Positive software limit and Negagive software 

limit settings are invalid. 

◼  Positive software limit(mm): If the software limit is enabled, this parameter is 

used to set the positive software limit value. If the software limit is not enabled, 

this parameter is invalid. 

◼  Negative software limit(mm): If the software limit is enabled, this parameter is 

used to set the negative software limit value. If the software limit is not enabled, 

this parameter is invalid. 



 

◼  Linear: Set whether the axis is a linear axis or an analog-digital axis. If it is set as 

an analog-digital axis, select No here, and set the system's analog-digital axis 

function to enable through parameter 1011 in the PLC logic; 

◼  Meaning of Position attribute: indicates whether the position of the axis is set 

to the command position or the actual position of the feedback; 

◼  Present: used to set whether the axis is available. If it is set to No, the axis is no 

longer controlled by the motion command. Usually during simulation test, in order 

to avoid the CNC sending an alarm and entering the holding state due to 

unconnected motor or servo failure, etc., this parameter can be set to No, but it 

needs to be set to Yes under normal motion control conditions. 

 

Measure： 

 
◼ Transducer type: Set the encoder type. The supported types are: incremental, single-

turn absolute, multi-turn absolute, and no transducer. 

✓  Incremental (incremental): The zero point needs to be searched every time it is 

started. 

✓  Single-turn absolute: It can determine the angle within a circle. 

✓  Multi-turn absolute: In addition to determining the angle within one lap, it can 

also determine the number of laps. 

✓  No transducer: open loop output control without encoder feedback to the 

controller. 



 

◼ Save axis position: If it is set to Yes, the CNC will save the axis position data and the 

homing flag in the power-down retention area. The position data can be loaded at the 

next startup, and the homing flag will be set at the same time. When the encoder 

alarms, then The homing flag will be cleared. This function is mainly used to simulate 

an absolute encoder axis. When the device is not running, the axis will be locked. If the 

servo used does not support the brake function, it must be set to No here; 

◼  Monitor transducer alarm: used to monitor the status of the encoder hardware 

function. This function depends on the servo function used. Some servos support this 

function, and some servos do not support this function. If the servo does not support 

this function, this function should be disabled. 

◼  User units per motor revolution: motion equivalent, which means the distance (mm) 

that the motor moves in one revolution. 

◼  Max position for module axis: Indicates the maximum angle or position of the motor 

rotation. When the maximum angle or position is reached, it will go to the starting 

point 0, which is only used for the module axis, usually set to 360. 

◼  Encoder lines per motor revolution: the number of encoder lines. The number of 

encoder lines is different from the number of pulses generated by one rotation of the 

encoder. Generally, moving one grating slot corresponds to 4 encoder pulses. This 

parameter is usually set according to the parameters of the motor or the encoder 

actually used. 

✓  SLM axis is set to 16384. 

✓  Mechatrolink bus axis is set to the number of pulses. 

✓  Set other encoder types as 

 

 

"The number of pulses required for one revolution of the motor/4". 

（The two VECServo motors connected here are both 2500-line incremental motors） 

◼ Invert count: Set the counting direction of encoder feedback signal. For some axes 

(such as analog control and other types of axes), when changing the direction of motor 

rotation, you need to change the counting direction of the encoder AB phase through 

this parameter at the same time. For the axis controlled by digital quantity, this 

parameter can be ignored. Because this parameter mainly sets the A and B phase 

counting direction of the encoder. 

◼ Offset of absolution transducer: The position offset of the absolute encoder. For 

example, the current absolute position of the axis is 1000, and the offset value is set to 

900, the displayed axis position is 100. 

◼ Position delay: The number of delay cycles for the controller to read the position 

information. The unit is the axis interpolation cycle of the motion controller. It will be 

affected by multiple factors:： 

✓  When the system performs pulse + direction control, there will be a difference of 

1 cycle between the pulse command sent each time and the position information 

read. 

✓  When the EtherCAT transit bridge is used for pulse control, the delay will be 

affected by the DC time of the EtherCAT bus, so the delay period is 3. 



 

✓  If a bus-type servo is connected, the actual position of the axis from the servo 

to the controller has to go through many transmission links of the communication 

protocol, especially when using the EtherCAT or Mechatrolink bus, each position 

command sent may require the servo to run for several cycles, so At this time, the 

delay can be set to 4-5. Sometimes the value is not an integer, so it can only be 

partially compensated. 

✓  If the following error of the axis is calculated and controlled by the servo drive, 

the delay will be meaningless. But if it is calculated by the controller, this value 

needs to be set, but in this case, the calculated error value does not represent the 

actual error value of the axis, but will be added to the instantaneous speed of the 

axis for compensation. 

✓  If the position closed loop is realized by the controller, the PID adjustment is 

actually not accurate. Although the following error value can be controlled within a 

reasonable range, the frequent adjustment of the instantaneous speed will cause 

certain vibration or vibration when the speed changes. There are problems such as 

speed crossing, so this method is not recommended when the communication 

cycle is relatively long. 

✓  Servo is used to realize the position loop. In this case, sometimes the following 

error value is relatively large due to the following performance problems of the 

servo, so the error threshold needs to be set larger in the CNC. 

✓  The reasonable setting range is 0-8. When it is set to 0, it means no delay, but it 

depends on the processing of the following error and the performance of the 

servo. 

◼ Encoder Ratio: Indicates the ratio of the number of pulses sent by the controller to the 

number of feedback pulses received by the encoder. For example, when controlling a 

stepper motor, the number of control pulses is calculated according to the number of 

steps, but the feedback encoder may have different resolutions. If it is set to 0, it means 

"Ratio=1". If it is greater than 1, it means that the number of pulses sent is greater than 

the number of feedback pulses received. If it is less than 1, the opposite is true. Note: If 

the set value is too large, the number of pulses collected and the number of pulses 

output by the interpolation calculation may be seriously inconsistent and a warning 

message of 1034 may be reported during the CNC homing process. 

 

 

Motion： 



 

 
◼ Maximum speed: Indicates the maximum speed that a single axis can reach. The unit 

of the previous parameter is mm/sec, which is the speed value after user equivalent 

conversion. Do not exceed the actual rated speed of the motor when setting it; 

◼ Nominal acceleration: The maximum acceleration value supported by the mechanical 

structure of the axis or the motor indicates the maximum speed value that can be 

reached in one second when a single axis is moving rapidly. 

◼ Nominal deceleration: The mechanical structure of the axis or the maximum 

deceleration value that the motor can support. If this parameter is set to 0, it means 

that the deceleration value and the acceleration value are the same. This value can be 

set to a value different from the acceleration. If the motor and the machine are 

connected with high elasticity (such as belt drive), usually set the acceleration value to a 

higher value to reach the target position quickly, and set the deceleration to a lower 

value to reduce Small error, this situation is more obvious when pushing the axis 

control, because the inertia may cause the object to separate from the control axis at 

the end of the movement, which causes the object to exceed the range of motion, but 

the axis is at the target position of the control. 

◼ Jerk for independent axis: Set the jerk value of a single axis (Jerk). 

 

⚫ Positioning time(ms)和 Position threshold(um): These two parameters are used to 

confirm whether the axis has reached the target position after the movement. If the 

difference between the actual position of the axis and the theoretical value is within the 



 

range set by the Position threshold and lasts for the Positioning time, the CNC 

considers that the axis has reached the target position of the current command and 

can continue to execute the next step. A motion control instruction. Otherwise, CNC 

has been waiting for the end of the movement. If one of these two values is set to 0, 

the function is disabled. 

Notice: 

1. If the axis has no encoder feedback, such as stepper motor open-loop control, this 

function must be disabled. 

2. If the axis does not need to compensate for the following error, such as pulse + 

direction control, you can set a reasonable value according to the magnitude of the following 

error. 

3. In general, if you want to activate this function, it is recommended to set the Position 

threshold between 100 and 200, and the Positioning time between 10 and 50. 

⚫ Backlash compensation(um): Backlash compensation. It is generally used to 

compensate the error caused by the gap of the mechanical transmission structure (such 

as the lead screw) when the shaft is reciprocating. The unit is um. If the gap to be 

compensated is 0.1mm, you need to enter 100. 

⚫ Feed forward: Feed forward ratio. If it is set to 0, it is 100%, and if the value is greater 

than 100, it is limited to 100%. For speed feed forward (VFF) enabled, the usual value is 

100. For Mechatrolink axis, it cannot exceed 80%. This parameter is synchronized with 

PN109. For EtherCAT axis, this parameter will be linked to the F.F. parameter of the 

servo. If VFF is not enabled or under position mode control, this parameter has no 

practical meaning. 

⚫ Invert direction: Set the direction of movement of the axis. If it is set to No, the motor 

moves clockwise to perform incremental motion, if the value is set to Yes, the motor 

moves counterclockwise to achieve incremental motion. 

 

EtherCAT： 

The configuration window needs to be opened after the EtherCAT bus configuration is 

completed. You need to map the axis configured by the control system to the connected 

axis device, open the EtherCAT tab, as shown in the figure below, set the Logical address to 

the logical address of the EtherCAT device , And then click the Read configuration button; 



 

 

Ensure the logical address of the EtherCAT device and the corresponding axis number, 

and then click the Read file button to automatically establish the PDO mapping, and finally 

click OK. 

 
 

After configuring Axis0, switch to another axis, and then follow the Axis0 configuration 

steps to complete the axis's general parameter configuration； 



 

 

 

Follow the above steps to complete the configuration of all axes, click OK to save and 

download; 

Note: The modification of all functions or parameter configuration through the 

configuration tool will take effect after restarting the system. 

  



 

Build a project quickly： 

1. Open the MULTIPROG Express software, the interface is as shown in the figure below： 

 
2. Open the "New Project" window through "File" >> "New Project" or through the icon in 

the toolbar, as shown below： 

 
3. Double-click the "Template ISAC Ilium" template to create a new function, but the newly 

created project is saved in a temporary file and needs to be saved as another folder. In 

the default project path saved as MULTIPROG, the name is IliumSamplePLC; 



 

 

 

4. Modify the resource type to match the currently used CPU type. Right-click the 

"Resource" node in the project tree, select "Properties", the following window will pop 

up： 

 

In the software structure of IEC61131-3, the resource is equivalent to a CPU. After the 



 

software is installed, the following types are explained here： 

ARMThumb2_LE_ARM_C-A589 For CortexA9+WEC2013 embedded 

platform 

I486_LE_MSC12 For X86 platform 

 

Because we currently use the CortexA9+WEC2013 embedded platform, here we choose the 

resource type as ARMThumb2_LE_ARM_C-A589, click OK； 

 

5. If after confirming, if the following prompt pops up, click OK； 

 
 

6. Right-click the "Resource" node in the project tree and select "Settings". A setting 

window will pop up. In the setting window, the communication parameters are set to 

"1.1.1.1-p41100" (in this example, the IP address of the controller is 1.1.1.1), at the same 

time, set the computer's IP address to "1.1.1.X" (the controller must be in the same IP 

segment as the PC's network IP, otherwise it will not be able to connect), and the 

version creation setting drop-down box Just select the bottom one, as shown below； 

 

PC 的 IP 地址： 



 

 

 

7、After the above parameter configuration is correct, you can open the project control 

window through "Online -> Project Control" in the toolbar； 

 

If the communication is successful, the status information will be displayed in the 

pop-up engineering control dialog box (if running is not displayed, click cold start);

 



 

 

Click the "More" button in the dialog control of the project control, and select the option 

"Permanently reside as a boot project" in the pop-up "Download Options" dialog box. 

Then close. 

 

8、Upload system configuration: To upload configuration information, you need to open 

the "View -> Motion Control Resources" window, as shown in the figure below; 

 

Project parameter initialization: Open Motion Control Resources >> Settings >> Motion 

project properties；



 

 
 

Click ok； 

 
Click "Yes" in the pop-up dialog box。 

 

Upload system parameters: If the parameters have been configured in the running 

system, upload the parameters before each download, and then compile to ensure the unity 

of the configuration parameters: Open the "Project Control Dialog Box" in MULTIPROG to 

establish online communication ,As shown below； 



 

 
Click the "Upload Configuration Information" button to upload the parameters, and 

after the upload is successful, the connection will be automatically re-established； 

 

Recompile using uploaded parameters。 

Create a simple program： 

After the configuration information is uploaded successfully, you can start to write the PLC 

program. In the above case, we configured the communication parameters and axis 

parameters of the two servo axes. Here we directly use the established configuration to 

directly write a simple PLC program. The program functions include: axis enable, speed 

operation, electronic gear operation, and Stop; right-click the blank space in the 

programming interface and click variables, as shown in the figure below: 

(1) New variable: 

a. Open the variable worksheet, right-click the blank space, click Insert Variable, and insert 4 

variables respectively. The variable name, type and initial value settings are as shown in the 

figure below; 



 

 
b. Right-click the blank area of the program editing interface and add V000 and V001 to 

the program, as shown in the figure below: 

 



 

 

c. Right-click the blank area of the program editing interface, and create two new variables: 

Axis0.AxisNo, Axis1.AxisNo, the properties are shown in the figure below, add them to the 

program, and then assign the values of V000 and V001 to Axis0.AxisNo and Axis1 

respectively. AxisNo is shown in the figure below: 

 

 

 



 

 
 

(2) Insert function block instruction 

a. In the programming wizard window, find the MC instruction library, insert two 

enable modules, MC_DriverEnable, hold down the left mouse button and drag to the 

programming interface, and then let go. At this time, the properties of the module will 

pop up. You need to name the module, generally keep it The default is OK, click "OK", as 

shown in the figure below: 

 

 

 

Double-click the module input pin (blue dot), and the "variable attribute" box will 

pop up to define the variable name, data type, usage, initial value, etc.; (the user can just 



 

fill in the axis parameters and introduce the parameters that cannot be defaulted. Yes, 

please refer to 6.2.3.1.3), as shown in the figure below: 

 

 
variable name type of data Initial value 

Axis0 AXIS_REF 0 

Enable0 BOOL 1 

En_Driver0 BOOL 0 

En_Postive0 BOOL 1 

En_Negative0 BOOL 1 

Axis1 AXIS_REF 1 

Enable1 BOOL 1 

En_Driver1 BOOL 0 

En_Postive1 BOOL 1 

En_Negative1 BOOL 1 

 

b. In the same way, insert the speed module MC_MoveVelocity from the MC instruction 

library, enter the variables, and click "OK", as shown in the figure below:



 

 

variable name type of data Initial value 

Axis0 AXIS_REF 0 

Vel_V0 LREAL 500.0 

Vel_Acc0 LREAL 1000.0 

Vel_Dec0 LREAL 1000.0 

Vel_Jer0 LREAL 10000.0 

Vel_Ex0 BOOL 0 

Vel_Update0 BOOL 0 

Vel_Dir0 INT 1 

Vel_BM0 INT 0 

 

c. In the same way, insert the electronic gear module MC_GearIn from the MC instruction 

library, enter the variables, and click "OK", as shown in the figure below:



 

 
variable name type of data Initial value 

Axis0 AXIS_REF 0 

Gear_Acc LREAL 1000.0 

Gear_Dec LREAL 1000.0 

Gear_Jer LREAL 10000.0 

Gear_Ex BOOL 0 

Gear_Update BOOL 0 

Gear_Num INT 1 

Gear_Den UINT 2 

Gear_MVS INT 0 

Gear_BM INT 0 

Axis1 AXIS_REF 1 

 

  d. Using the same method, insert the stop module MC_Stop from the MC 

instruction library, enter the variables, and click "OK", as shown in the figure below: 



 

 

 

variable name type of data Initial value 

Axis0 AXIS_REF 0 

Stp_Dec LREAL 1000.0 

Stp_Jer LREAL 10000.0 

Stp_Ex BOOL 0 

 

At this point, the program is established. 

 

  



 

PLC program downloading and debugging  

(1) Program compilation and production 

After the program is edited, click the menu "Create -> Make", or click the button on the 

toolbar. After there is no error prompt in the information status area, proceed to the next 

step of downloading the program. If there is a prompt, double-click the "under the message 

area" "Error" prompt, the software automatically jumps to the wrong place, click "Make" after 

the modification is completed, until there is no error prompt in the information status area; 

 
 

(2) Download the program 

After the program is made, click the menu "Online -> Project Debugging" to open the project 

control dialog window, as shown in the figure below; 

 
Click More, in the pop-up download options, check "As a boot project permanent residence", 

click Close; 



 

 

Then click "Stop -> Reset -> Download" in the project control dialog box in turn, and wait 

for the download to complete; 

 
After the message window "shows that the download setting has been successfully 

completed", click the cold start to run the program, and the status display will change to 

"running". 

 
 

(3) Program debugging 

Under the premise that the status displayed in the project control dialog box is running, click 



 

the menu "Online -> Debug", or click the debug button on the toolbar ，Open the 

program monitoring and debugging, as shown in the figure below; 

 

Action steps: 

a. First enable the servo before starting, double-click the MC_DriverEnable blue input points 

"En_Driver0", "En_Driver1", and set the value to Ture (when it needs to be turned off, the value 

is set to False), click to overwrite, "En_Driver0", "En_Driver1" "Will change from False to Ture, 

as shown in the figure below; 

 



 

 

b. After the servo is enabled, set the "Vel_Ex" of the MC_MoveVelocity_1 module to Ture, 

trigger the speed command of axis 0, and axis 0 will start to run according to the set speed 

parameters, as shown in the figure below; 

 

c. After the axis 0 is started, set the "Gear_Ex" of the MC_GearIn_1 module to Ture, trigger the 

electronic gear coupling command, and axis 1 will follow the main shaft to move the electronic 

gear according to the set electronic gear ratio and speed parameters, as shown in the 

following figure; 



 

 
d. When the movement is stopped, set the "Stp_Ex" of the MC_Stop_1 module to Ture, trigger 

the stop command, axis 0 will decelerate to a stop according to the set deceleration 

parameters, and axis 1 will follow the axis 0 to go the electronic gear, so axis 1 will also Follow 

the spindle to decelerate and stop, as shown in the figure below; 
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